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Chapter 1 
Getting started 

Overview 
Alphacap enables companies to manage their asset portfolios effectively from a 
tax perspective, enabling them to post capital asset data into Alphatax Enterprise 
so that capital allowances and capital gains can be claimed in the Alphatax 
computation. The main features are described below: 

 The Batch data input area under the Administration heading in the Contents 
tree enables you to enter data easily from other systems into Alphacap. 

 The Projects area under the Administration heading in the Contents tree 
enables you to handle costs that need to be apportioned across large projects, 
in proportion to the tax characteristics of the other expenditure 

 Once data has been entered and transferred to the Alphacap database, the 
Summary view section enables you to view lists of capital asset data in five 
pre-defined views. Within each view it is possible to further define the 
displayed data via user-created filters. 

 You can also use the Summary view statements to select items to work on in 
more detail. 

 Full capital disposal calculations are produced and can be viewed together 
with notional gain calculations based on valuations data. 

 Once you have selected an item to work on, you can refine the information for 
each asset further by entering expenditure items valuations and disposal 
details including rollover and postponement relief. 

 Once you have entered expenditure, valuations and disposal details, data can 
be posted into Alphatax Enterprise. Information on capital allowances feeds 
into the Alphatax capital allowances statements via the Accounts Analysis 
section and information on capital gains disposals feed into the Capital 
disposals section. 

 There are comprehensive reporting options including all options available in 
the Alphatax Report Designer. 

 The Document Manager function is also available allowing documents to be 
electronically attached to assets. 
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Using the Alphacap desktop 
Information on using the desktop is given in detail in the online Help under the 
heading Getting started. A summary is given below.  

Starting the software 
1. At the Start button, select Alphacap. 
2. Alternatively, double-click on the Alphacap shortcut icon on the desktop, 

which is created on installing the program. 
 
The Alphacap desktop (Main View) is displayed 

 

Using the menu bar 
For details on options accessed via the menu bar, refer to the online Help 
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Using the Tool bar 
The Tool bar is the row of buttons at the top of the main window which represent 
application commands. Clicking one of the buttons is a quick alternative to 
choosing a command from the menu.  Buttons on the Tool bar are activated and 
deactivated according to the state of the application. 

 Save the latest action 

 Print the currently-open statement or report  

 Switch to Report mode 

 Cut selected text to Clipboard 

 Copy selected text to Clipboard 

 Paste selected text to Clipboard 

 Undo previous command 

 Go back to the previously selected statement 

 Browse forward through selected statements 

 Find selected text 

 Repeat previous find operation 

 Display Help Contents 

 Display the Notes window 

 Open Alphatax Enterprise 
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Using the Contents list 
The Contents list on the left lists the statements that are to be worked on. The 
Contents list is divided into a number of sections under headings. Icons are used 
to differentiate between heading levels and document types: 

 Heading 

 Input statement 

 Expandable indicator 

 Expanded indicator 

Titles can easily be expanded or hidden from the list.   When the list is expanded, 
lines show the statement ownership. 

Using the Reports list 
The Reports contents list offers an efficient method to review the results of the 
computation performed by the software on the entered data. 
The list is divided up into sections separated by headings.  Within each section, 
Report statements are listed either with the statement reference or ‘-’ (a dash) if 
suppressed for the tax computation printed report. 

Switching between Report mode and Input mode 
Use Report mode to view the tax computation on screen.  The reports and return 
form may then be printed. Use Input mode to enter data. 

 Choose Report mode from the View menu, press the F7 key, or click the 
toolbar icon. 

The Report contents list is displayed and a tick is displayed against Report mode 
in the View menu. 
 
To return to the Contents list and enter data, choose Input mode from the View 
menu, press the F7 key, or click the toolbar icon.  
The Contents list is displayed and a tick is displayed against Input mode in the 
View menu. 

Completing an Input statement 
All data required for the capital assets report is entered within Input statements.   

Input statements are identified on the Input contents list with the  icon. 

Some Input statements are user-created. For example, each asset has its own set of 
Input statements. 
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Accessory statement 

          

Item rows on many  Input statements enable you to enter additional detailed 
information on an Accessory statement. Where this is the case, the Accessory 
icon is shown beside the row.  

1. Select a row. 
2. Choose Accessory from the View menu, press the F8 function key or click 

the Accessory icon. 
The Accessory window pops up with an identifying title 

3. Press the TAB key to move the active cell to the next input.  Use the F2 
function key to amend previous inputs.  

4. To close the Accessory statement, press either the ESCAPE key or the F8 
function key. 

5. You can copy the complete information for a row including data on the 
Accessory statement. 

Note. Once you have entered data on an Accessory statement, the icon is filled in. 

Context-sensitive help 
Press F1 to display Help for the Input statement you are completing. 
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Printing or previewing documents 
1. Make sure you have selected the printer to be used in Printer setup. 
2. Choose Print or Print Preview from the File menu. 
3. From the sub-menu, select one of the following options: 
 Current view 
 Capital assets report 
 Custom report 

4. For printing, specify the pages to be printed, and number of copies to be 
printed on the Print dialog. 
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Chapter 2 
Batch data entry 

This chapter describes how to enter the initial data for capital assets processing 
and how to transfer this data to the Alphacap database. 
This chapter covers: 

 Overview 
 Creating and maintaining datasets 
 Transferring data to the Alphacap database 
 Audit tracking 

Overview 
You can create datasets from within the Alphacap Main View window on a 
company by company basis and manage their progress via new dataset summary 
views. It is possible to create, save and work on multiple datasets. 
The dataset itself opens in a separate Dataset View window enabling you to work 
on multiple datasets.  
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Creating and maintaining datasets 

 

Creating a dataset 
To create a dataset, open the Batch datasets item in the Contents tree and highlight 
any of the Additions, Disposals or Valuations headings. 
Choose New dataset from the File or right mouse click menu.  

 

In the Type field, select the dataset type. This can be Assets/Expenditure, 
Disposals or Valuations. 
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The companies that are available to you in Alphatax are listed below. Select the 
required company and choose OK. 
The new dataset opens in a separate Dataset View window. 

 
Note. You can switch between Main View and Dataset View by choosing the 
appropriate options from the Windows menu. 

Batch data input 
The options available for batch data input vary depending on whether this is an 
Additions, Disposals or Valuations dataset. For full details, refer to the online 
Help. 
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Assets/Expenditure dataset 

 

Use the Assets/Expenditure dataset to enter fixed assets and expenditure items. 

Disposals dataset 
Use this statement to enter all fixed asset disposals. 
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Valuations dataset 
Use this statement to enter all fixed asset valuation details. 
Note. For Expenditure and Disposals, you can record Per accounts figures for 
reconciliation purposes.  

 

Marking data as provisional 
You can identify data as provisional for any cell in any dataset. 
With your cursor in the appropriate cell, select Provisional value from the right 
mouse click menu. 
The cell now becomes yellow. 
When the item is confirmed as no longer provisional, toggle the Provisional 
value tick box off on the right mouse clock menu. 

Verifying data 
In Dataset View, a new Verify dataset option in the Tools menu enables 
Alphatax to check for errors before transferring data to be worked on in Alphacap 
working area. 
Alphacap checks whether data is incomplete, unreconciled and/or provisional and 
displays a warning message if this is so. 
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Dataset mapping and CSV import/export 
You can import data to Alphacap from other applications via CSV files. To 
facilitate the import you can create a mapping file that links your source file and 
the Alphacap dataset. 
Expenditure data downloaded from external systems may already have some tax 
flags which could be of use within Alphacap.  Where this is the case, it is possible 
to map this information into Alphacap by setting up user definable rules.  These 
will then be applied on importing a csv data file. For example, an external tax flag 
of ‘LAND’ could be mapped into Alphacap as follows: 

 CA category – Ineligible 

 CG category – Chargeable 

 Qualifying for rollover relief – Yes 

Dataset import rules 
While in Dataset View, use the Dataset import rules statement in the 
Administration section of the Contents tree to map the tax flags used in your CSV 
import files to Alphacap capital allowances and capital gains categories. 
It is also possible to define the rollover qualifying status of a tax flag. 
Where Projects are in use (see page 22), you can also specify that particular 
categories are not included in the apportionment calculation in the Project 
calculation window. 
Dataset import rules will be applied on the first save after importing a csv file. 
As part of Alphacap’s internal validation checks, any external tax flags present in 
a particular data file which have not been previously used will be identified on 
import.  The user will be required to map these appropriately before the dataset 
can be saved.  
One set of rules can be saved per company and once saved these rules will 
automatically be available within any newly created Datasets for that company.   
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Creating a mapping file 
In Dataset View, open the relevant Batch data input statement and then select the 
Dataset import setup option from the Tools menu to create a mapping file. 
The Dataset Mapping dialog is displayed.  

 

You can create a new mapping file by choosing Blank or you can open existing 
mapping files that have been saved as templates. In this case, the Dataset Import 
dialog will be displayed (see page). 
Note. If your templates have been organised into folders, click the appropriate tab 
to select the required report. Click on the template required and choose OK. 
You are then prompted to select the CSV file for which you wish to set up a 
mapping file. 

Highlight the required file and choose Open. 

The Dataset Import Setup dialog is displayed. This has three tabs: 

 Data File 

 Defined columns 

 Mappings 
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Database Import Setup - Data File 
Selecting the Data File tab shows the contents of the source file in  columnar 
format.  
Note. The number and name of the columns depends on how your source file has 
been set up. 
Point the cursor at a selected row(s) and  then from the right mouse click menu, 
choose Define column headers  to define a new header row or Remove row(s) to 
remove a row or rows from the source file. 

Database Import Setup – Defined columns 
The Defined columns tab shows for each column, the title, data type, whether the 
column is mandatory and whether the column has been mapped 

Database Import Setup – Mappings 
Use the Mapping tab to create or edit mapping from the source file to Alphatax. 
Select a Datafile column and then choose Map Account Name form the right 
mouse click menu. The Select Mapping for Column ... is displayed enabling you 
to create the mapping. 
Repeat for each column you wish to map. 
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Saving the mapping file 
When you have mapped each item, choose Close. 
Note. A warning message is displayed if you have not mapped any mandatory 
columns. 
Use the Save As dialog to save the mapping file (in mfs format). We recommend 
 that you save the file to the Additions, Assets, Disposals or Valuations tab in the 
CAMapping folder in the main Alphacap directory. 

Importing a CSV file 
Choose Import CSV files from the File menu. The Database Mapping dialog is 
displayed. 
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Choose the required mapping file and then click OK. The Dataset Import dialog is 
displayed.  

 

This shows how the headings in the CSV file will be mapped to columns in 
Alphacap. 
Choose Import to continue. 
You will be promoted to select the csv file to import. 
The file will be imported to the Asset creation, Expenditure, Disposals or 
Valuations statement as appropriate. 

Exporting to a CSV file 
In Dataset View, open the relevant Batch data input statement. 

Select Export CSV File from the File menu. 
Select the CSV file to which you wish to export data. 
Specify whether to include a header row and/or whether to use tab separators. 
Choose Save. 

A message is displayed to tell you that the export was successful. 
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Transferring data to the Alphacap database 
Once you have added the required data to the dataset, select Transfer to database 
from the Tools menu. 
A progress bar is displayed while data is being added. On completion a log file is 
also displayed listing any processing errors that have occurred. 
Once data has been transferred to the database, you are ready to use the Summary 
views section to select items for further processing in the Working area section of 
the Contents tree. 
Within Dataset View, the data is now read only. 

Audit tracking  
In Main View, the new dataset summary views in the Batch datasets section of the 
Contents tree record the creation and transfer progress of a dataset, together with 
other summary details. 
If the data has already been transferred to the Alphacap database, the transfer date 
and the ID of the user who transferred the data will be displayed. 

 
Note. This information is also shown on the Dataset information Input statement 
for a particular dataset within Dataset View. 
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Filtering data 
You can specify criteria to limit the number of items displayed in any of the Batch 
dataset statements. To access the dialog, with any of the statements open, select 
Filters from the right mouse click menu and then choose Manage filters. 
For details, refer to the online Help. 

Deleting datasets 
Highlight the required dataset and choose Delete dataset from the right mouse 
click menu. 

Handling projects 
Alphacap allows expenditure to be tracked within Capital Projects.   
One of the key features of this is the ability to deal with expenditure that is 
deemed to contribute to the whole development and which can therefore not be 
specifically categorised for tax purposes (apportionable costs).   
For example this may include fees for surveyors and solicitors. Alphacap will 
perform calculations to apportion these costs across the Project as a whole, in 
proportion to the tax characteristics of the other expenditure. This apportionment 
will be updated and adjusted each accounting period where the Project spans more 
than one. In this way, Alphacap provides a sound and consistent methodology to 
ensure capital allowance claims for such expenditure are fair and accurate.     

How to record and allocate project expenditure 
In Dataset view, select the Expenditure Input statement in the Batch data Input 
section. 
To record expenditure for a project-related asset, a project reference is essential. 
 Enter a separate line for each item of expenditure as in the example below: 

Asset 
reference 

Cost CA Category CG 
Category 

Project 
reference 

A1 100.00 Plant WDA Chargeable P1 

A1 200.00 Hotel WDA Chargeable P1 

A1 300.00 Ineligible Exempt P1 

A1 20.00 Revenue items 
capitalised - 
allowable 

Revenue P1 

A1 60.00 Apportionable 
project costs 

APP P1 
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Note. A new Alphacap project is created automatically whenever a unique Asset 
reference/Project reference is recorded in this statement. 
Once details are recorded, use the Transfer to main database option to update an 
existing project or create a new project. 
Apportionable costs (i.e. those entered with the CA category Apportionable 
project costs) will be automatically allocated across the CA and CG categories of 
the other costs in the Alphacap project. 

Reviewing project expenditure 
In Main View, select the appropriate project from the Projects window. 
The selected project is opened in Project View. 
In the Administration section, open the Project information Input statement to 
view an overview of the project. 
To review project expenditure, select the Project calculation window for the 
appropriate period from the Project calculation section of the Contents tree. 

Using the Project calculation window 
The Project calculation window shows how the costs have been apportioned 
across the project for an accounting period. 
The window shows the Cost to apportion based on entries in the Expenditure 
Input statement for this asset/project combination as in the example below: 
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Working area 
In the Working view, the apportioned costs are shown as separate lines in the 
Expenditure Input statement . The Description column uses the Project 
reference//End of period date to identify that this is apportioned expenditure as in 
the example below: 
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Chapter 3 
Working on assets 

Selecting assets to work on 
Use the Summary view statements to view summary details of assets and  to select 
them to work on in the  Working area section. 

Managing the display of information 
To help manage the display of information, you can: 

 Shrink the width of columns, hide columns and sort the display on any 
 particular column. 

 Use the right mouse-click menu to create or select filters to restrict the 
display of any items to those matching criteria you define (page 26). 

 Select an item to work on by double-clicking the folder icon at the left.  
 
The statement for the selected item will open in the Working area section 
(see page 29). 

For full details on any of the Summary views, refer to the online Help. 
You can view assets in the database sorted by: 

 Companies. The Companies view shows information for each company 
available in Alphacap. 
 
Note that companies do not need to be created separately in Alphacap as 
the company details are picked up directly from Alphatax. 
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 Assets. The Assets view shows information for each asset within the 
database. 

 Expenditure. The Expenditure view shows details individual expenditure 
items. 

 Disposals. The Disposals view shows details of any asset disposals. 
 Rollover relief. The Rollover relief view shows details of rollover relief 

claims that have been made in Alphacap. For details on claiming rollover 
relief, refer to page 37 

 Postponed gains The Postponed gains view shows details of all 
chargeable gains postponed under TCGA 1992 s154. 

Filtering the data 
You can specify criteria to limit the number of items displayed in any of the Batch 
dataset statements. To access the dialog, with any of the statements open, select 
Filters from the right mouse click menu and then choose Manage filters. 
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For details, refer to the online Help. 
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Using the Working area 
The Working area enables you to work on selected assets prior to sending relevant 
capital assets and capital gains data to Alphatax Enterprise. 

Working area hierarchy 
Any items selected from the Summary views statements are displayed in the 
following hierarchy: 
Company 

Trade or Non-Trade asset list (while an asset is still awaiting disposal) or 
Assets previously owned (once an asset has been fully disposed of) 

Asset details statement 
Ownership 
Valuations 
Expenditure 
Disposal (can be Full, Partial, or Awaiting disposal) 

Expenditure 
Rollover relief (including postponement relief) 
Rollover relief history list 

Submitted claims 
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Companies level 
For the selected company, the Company Input statement enables users to view or 
edit brief details about the company holding the asset(s). 
For details, refer to the online Help.  

 

Asset level 

Asset list 
The Asset list Input statement shows existing assets held by this company for the 

 Specified trade; or  
 Under the Non-trade heading if the assets are not held by a trade within the 

company.; or 
 Under the Assets previously owned heading if the assets have been fully 

disposed of or transferred to another company 
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You can edit information and you can add or delete assets, if required. 
Once data is entered in the Description, Asset reference and Date acquired 
columns, you can click the drill down icon to record or view more information 
about the asset in the Asset details Input statement. 

Deleting assets 
Highlight an asset and then choose Delete asset from the right mouse click menu. 
The asset is listed under the Marked for deletion heading on the Asset list 
statement. 
The asset is not actually deleted until you close the appropriate Company in the 
Working area. 
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While the asset is marked for deletion, you can use the Undelete asset command 
from the right mouse click menu to re-instate it. 

Assets previously owned 
Fully disposed assets or assets that have been transferred to another group 
company will be listed under the Assets previously owned heading in the 
Working area section of the Contents list. 
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Fully disposed assets listed here can be accessed as normal by clicking on the drill 
down arrow. 
For assets transferred out, clicking on the drill down arrow will display details of 
the transfer. To access the standard full asset details, highlight the asset and then 
choose Open asset from the right mouse click menu. This will open up the asset 
under its owner company in the Working area. 

Asset details 
The Asset details Input statement enables you to enter or edit asset details. 

 

For details, refer to the online Help. 
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Ownership 
Use the Ownership statement to view or record ownership details for an asset. 

 

An entry in this statement will be made automatically when an asset is first 
created. 

Valuations 
Use the Valuations statement to record valuations details.  

 

For further details, refer to the online Help. 
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Expenditure statement 
Enter details for each item of expenditure.  

 

The Accessory statement displays details of the rollover relief qualifying status 
under TCGA 1992 s155 of the expenditure item. By default the status of the 
expenditure item is taken from the asset. Use the Overrride asset level for this 
item of expenditure? field  where the expenditure status differs from the asset. 

 

For further details, refer to the online Help. 
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Disposals 
The Disposal statement enables you to record disposal details.  

 

For details, refer to the online Help. 

Expenditure 
Expenditure that forms part of the disposal is displayed. 
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Rollover relief 
For details on rollover and postponement relief, refer to page37 in Chapter 4. 
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Chapter 4 
Claiming rollover and  
postponement relief 

This chapter shows you how to handle rollover and postponement relief in 
Alphacap. 

Overview 
In the Working area, open the appropriate Rollover relief Input statement to 
record rollover relief under TCGA 1992 s152 or postponement relief under TCGA 
1992 s154. Alternatively in Summary View, go to the Rollover relief or 
Postponement relief window and select the required asset. 
The Rollover relief Input statement opens up. 
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Rollover relief under TCGA 1992 s152 
Where the asset disposed of is a qualifying asset under TCGA 1992 s155, you can 
use the Rollover relief Input statement to rollover a qualifying gain. Roll-over 
relief under TCGA 1992 s152  involves a gain, or a part thereof, being treated as 
a reduction in the cost of another asset purchased rather than being subjected to 
tax.  
Where the asset disposed of is a qualifying asset under , you can use the Rollover 
relief Input statement to rollover a qualifying gain. Roll-over relief under  
 involves a gain, or a part thereof, being treated as a reduction in the cost of 
another asset purchased rather than being subjected to tax.  

Postponement relief under TCGA 1992 s154  
Where the asset disposed of is a qualifying asset under TCGA 1992 s154, you can 
use the Rollover relief Input statement to postpone qualifying gain. The relief 
under TCGA 1992 s154  involves a gain, or a part thereof, being treated as held in 
suspense (not rolled into the base cost of another asset purchased) rather than 
being subjected to tax. The gain will crystallise at the earliest of: 

 Disposal of the asset 

 Asset no longer used in the trade 

 Ten years from the date of acquisition of the asset 

Where the asset disposed of is a qualifying asset under , you can use the Rollover 
relief Input statement to postpone holdover qualifying gain. The relief under 
TCGA 1992 s154  involves a gain, or a part thereof, being treated as held in 
suspense (not rolled into the base cost of another asset purchased) rather than 
being subjected to tax. The gain eventually crystallises at the earliest of: 

 Disposal of the asset 

 Asset no longer used in the trade 

 Ten years from the date of acquisition of the asset 
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Identifying and claiming relief 
To identify assets into which you can rollover or postpone a gain and then to 
claim the relief, select Rollover relief  from the Tools or the right mouse click 
menu. 
At the top of the dialog, the current reinvestment date window is displayed.  This 
defaults to the period beginning 12 months before and ending 3 years after the 
disposal, as provided by TCGA 1992 s152(3) but you can override this, if 
required. The system-calculated amounts eligible for rollover are also displayed. 
Again you can override these, if required. 

  

Choose Add to make the claim. The Rollover relief claim- Gain dialog is 
displayed. 
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Use this dialog to identify expenditure made into which you can rollover or 
postpone capital gains. 
By default, the search will interrogate the Alphacap database and return 
expenditure items which meet all of the following criteria: 

 Belongs to a company in the same capital gains group as the disposal 
company 

 Qualifies for rollover or postponement relief under TCGA 1992 s152 or s154 

 Purchased within the reinvestment date window 

You can further refine the data. For details, refer to the online Help. 
Select the expenditures into which the gain is to be rolled over by clicking on the 
check box at the left of each expenditure. 
Choose OK. 
The assets are then listed in the Rollover relief dialog where you can allocate the 
proceeds as required.  
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To allocate proceeds between expenditures, in the Proceeds column, double-click 
the appropriate cell and type the amount to be allocated. 

 

The system will calculate the gains allocated on a proportional basis, however this 
can be overridden using the Override column. 
Note. Both these columns have a box to indicate that cells can be edited. 
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At the foot of the dialog, the current totals are shown. 
To remove expenditures from the list, click the Remove button. 
Note. A warning is displayed if you attempt to select an asset which is already in 
use. 
Click OK when the allocations are complete and this will update the capital gains 
calculation.  A rollover relief report is also generated which can be submitted to 
the HMRC as the claim under TCGA 1992 s152. 
Once you have made a rollover or postponement claim, you can select to work on 
it via the Rollover relief or Postponed gains Summary Views screen. 

 

Submitted claims 
The Submitted claims Input statement is created when you choose Submit 
rollover claim from the Tools menu. 
The statement captures snapshot details of rollover or postponement relief claimed 
as at that time. 
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Using Alphacap 

44        Using Alphacap 



 

Autumn 2011       45 

Chapter 5 
Transferring, moving and splitting assets 

This chapter tells you how to: 
 Transfer assets under TCGA 1992 s171A 
 Move assets for administrative purposes 
 Create a new asset by splitting lines of expenditure in an existing asset into 

a new one 
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Transferring assets under TCGA 1992 s171A 
You can  transfer assets from one company or trade to another company or trade 
under TCGA 1992 s171. 
To do this, in the Working area section of the Contents tree, at any statement 
heading below and including  the Asset details statement, choose Transfer asset 
under TCGA 1992 s171 from the right mouse click or Tools menu. 
The Transfer asset dialog is displayed. 

 

Highlight the company to which you wish to transfer the asset.  
Select the trade to which you wish to transfer the asset or select non-trade if the 
asset is not trade-related. 
Choose OK when you are ready to proceed with transfer. Otherwise, choose 
Cancel.  
Note. Due to the differing capital allowance categories that are available for 
trade and non-trade assets, where you are moving an asset between trade types, a 
warning will be displayed. Alphacap will attempt to correct the capital 
allowances category for all expenditure items but this should be checked carefully 
following the above procedure. Choose Yes to proceed. 
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Disposal for asset transfer 
Once you have selected the company and trade to which you are transferring an 
asset under TCGA 1992 s171, the Disposal for asset transfer dialog is displayed. 

 

The Asset info section is populated with information about the asset and the 
company and trade to which it is being transferred. 
Use the MV at transfer date, Proceeds and Tax disposal value fields to allocate 
proceeds across all available expenditure items. 
You can override these allocated values manually on an item by item basis by 
clicking in the Proceeds override and Trf  override columns in the main body of 
the dialog.  
Note. Both these columns have a box to indicate that cells can be edited. 
Choose OK when you are ready to make the transfer. 
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Moving an asset 
You can move assets that have been incorrectly assigned to the correct company 
or trade.  
To do this, in the Working area section of the Contents tree, at any statement 
heading below and including  the Asset details statement, choose Move asset 
from the right mouse click or Tools menu. 

 

Highlight the company to which you wish to move the asset. (All companies in 
the system will be available.) 
Select the trade to which you wish to move the asset or select non-trade if the 
asset is not trade-related. 

Choose OK when you are ready to proceed with move. Otherwise, choose 
Cancel.  

Splitting an asset 
You can create a new asset by splitting lines of expenditure from an existing asset 
into a new one. 
Note. You can only split assets that have not yet been disposed or partially 
disposed of and where there have been no transfers in. 
In the Working area section of the Contents tree at any heading below and 
including the Asset details statement, choose Split asset form the right mouse 
click menu. 
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By default the New Asset Reference and New Asset Description fields will show 
the existing name and description with the /SPLIT appended. You can amend 
these as required. 

 

Select one or more lines of expenditure to split into the new asset. 
Choose Split and then Yes to proceed. 
You are then prompted to save the new asset. Choose Yes. 
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Chapter 6 
Posting data to Alphatax 

Before you can post capital asset data to Alphatax, you must first select 
Retrieve/refresh posting data from the Tools menu. 
At this stage Alphacap extracts period data from Alphatax for the company or 
companies currently in the Working area and generates a number of Report 
statements for each company. Summaries of Additions, Disposals, Transfer in and 
Transfers out  are reported by period at both company and trade level. 
You should normally review the posting data to check that you are happy with it 
before you select the Post to computations option. 
Note. If you make any changes, you must select Retrieve/refresh posting data 
again before posting to Alphatax. If you do not, Alphacap will not post any 
changes made since the previous Retrieve/refresh. 

Posting configuration options 
The following options are available when posting data to Alphatax: 
It is possible to specify the period on or after which you would like information to 
be posted.  This is to ensure finalized periods in Alphatax are not affected by 
Alphacap. 
On posting capital disposals, it is possible to enable Alphacap to summarise 
expenditure by month rather than transferring every line into the capital disposal 
calculation. 
Both of these options can be set globally and as default for all companies via the 
CaPostToATStartingDate and PostSummaryCG settings in the  
tcslbase.ini file and/or on an individual company basis via the Posting to Alphatax 
- configuration options section on the appropriate Company statement in the 
Working area as shown in the example below. 
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Posting to computations 
Use the Post to computations command to transfer data from Alphacap to 
Alphatax Enterprise.  
A dialog is displayed asking if you want to review company/period details before 
posting. 
If you select Yes, the Company information in Alphatax dialog is displayed. 
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If you select No, you are prompted to confirm whether you are ready to continue 
posting. Select Yes to post to Alphatax. Capital allowances data is fed through to 
the appropriate Alphatax Input statements via entries in the Accounts Analysis 
statements. Capital gains are fed through to the Capital disposals section in 
Alphatax. 
Note. When you select Post to computations, Alphacap will post data as 
prepared when you last selected the Retrieve/refresh posting data from the Tools 
menu. Any changes made since then will not be posted until your next 
Retrieve/Refresh. 
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Chapter 7 
Reporting and document management 

Reporting 
The Reports contents list offers an efficient method to review the capital assets 
data for a particular asset, trade or company. 

Posting reports 
These summarise Additions, Disposals, Transfer In and Transfers Out, by period, 
at both company and trade level, split by account category 
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Asset level reports 
These include: 

 Summary of disposals 
 Capital allowances summary 
 Chargeable disposals/ rollover relief reports 

 
Note. These Report statements are automatically included in the Capital assets 
report for all companies and assets that are open in the Working area. 
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Using the Report Designer 
The Report designer is a standard Alphacap function that enables you to design 
your own reports and print report templates. It includes the Report Viewer 
application allowing you to manipulate the format and layout of the reports. For 
details, refer to the online Help. 

Using the Document Manager 
The Document Manager enables you to store files in the Alphacap Enterprise 
database. Files in the Document Manager are associated with a particular asset, 
expenditure, disposal or valuation.  
Document Manager is accessed via the following options on the right mouse click 
menu: 

 Manage All Documents. Choose this option from within any statement in 
Input mode. 

 Manage Company Documents. Choose this option from within any 
statement in Input mode. 

 Manage Item Documents. Choose this option within a statement with 
duplicating items. The  icon is displayed in the Narrative cell for any 
item that has an associated document in the Document Manager. 

 You can open, add and delete files and you can store any binary file including: 
 Microsoft Office documents (Word, Excel, Powerpoint, Access) 
 PDF files 

For details, refer to the online Help. 
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